NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate information and data via a secure network. It is the sole responsibility of the system/product owner to provide and continuously ensure a secure connection between the product and the system network and/or any other networks that may be connected.

The system/product owners must establish and maintain appropriate measures, including, but not limited to, the installation of firewalls, application of authentication measures, encryption of data, installation of antivirus programs, and so on, to protect the system, its products and networks, against security breaches, unauthorized access, interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ultimately responsible to ensure that any system update (including but not limited to code changes, configuration file changes, third-party software updates or patches, hardware change out, and so on) is compatible with the security measures implemented. The system/product owners must verify that the system and associated products function as expected in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2016 by ABB.
All rights reserved.

Release: March 2016
Document number: 2PAA111022-600 C
Table of Contents

About This User Manual
General ........................................................................................................................................7
User Manual Conventions ......................................................................................................7
  Feature Pack .......................................................................................................................7
  Warning, Caution, Information, and Tip Icons .................................................................8
Terminology ................................................................................................................................9
Released User Manuals and Release Notes ........................................................................10

Section 1 - Introduction

Section 2 - Working with the ABB System Extension Configuration and Packager Tool
Creating a project ..................................................................................................................15
Adding files to be packaged ................................................................................................16
Providing System Extension Information ...........................................................................22
Saving and Opening a project ..............................................................................................26
Building a Package ..............................................................................................................26
  System Extension Packager ...............................................................................................27

Section 3 - Notifications

Section 4 - Product Installation

Section 5 - Tips and Requirements
Tips .........................................................................................................................................39
Requirements .......................................................................................................................40
Index
About This User Manual

General

Any security measures described in this User Manual, for example, for user access, password security, network security, firewalls, virus protection, etc., represent possible steps that a user of an 800xA System may want to consider based on a risk assessment for a particular application and installation. This risk assessment, as well as the proper implementation, configuration, installation, operation, administration, and maintenance of all relevant security related equipment, software, and procedures, are the responsibility of the user of the 800xA System.

This user manual describes about the ABB System Extension Configuration and Packager tool that is used to create a System Extension Package for the System 800xA.

User Manual Conventions

Microsoft Windows conventions are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, etc.

Feature Pack

The Feature Pack content (including text, tables, and figures) included in this User Manual is distinguished from the existing content using the following two separators:
Feature Pack functionality included in an existing table is indicated using a table footnote (*) :  
*Feature Pack Functionality

Feature Pack functionality in an existing figure is indicated using callouts.

Unless noted, all other information in this User Manual applies to 800xA Systems with or without a Feature Pack installed.

**Warning, Caution, Information, and Tip Icons**

This User Manual includes Warning, Caution, and Information where appropriate to point out safety related or other important information. It also includes Tip to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

- Electrical warning icon indicates the presence of a hazard which could result in *electrical shock*.

- Warning icon indicates the presence of a hazard which could result in *personal injury*.

- Caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in *corruption of software or damage to equipment/property*.

- Information icon alerts the reader to pertinent facts and conditions.

- Tip icon indicates advice on, for example, how to design your project or how to use a certain function.

Although Warning hazards are related to personal injury, and Caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result
in degraded process performance leading to personal injury or death. Therefore, fully comply with all Warning and Caution notices.

Terminology

A complete and comprehensive list of terms is included in *System 800xA System Guide Functional Description (3BSE038018*)*. The listing includes terms and definitions that apply to the 800xA System where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely apply to this User Manual are listed in the following table.

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSI</td>
<td>Microsoft Installer</td>
</tr>
</tbody>
</table>
| AFW or .afw  | Aspect Framework files  
This contains description about the Aspect Object data in static text. |
| System       | ABB 800xA System |
| System Extension | A System Extension consists of one or more applications that are bundled as an extension to one or several existing System Product(s). A System Extension can only be installed if (one of) the corresponding System Product(s) has been installed previously. |
| Project      | A System Extension Project consists of:  
1. Files to be packaged.  
2. Definitions for System Extension to be generated.  
3. Respective installation package.  
The project saves the configuration to a .xml file that user can be reused later. |
| ADD          | Aspect Data Definitions  
This is generated by the Aspect Wizard and contains the definition of Aspect System, type and category. |
Released User Manuals and Release Notes

A complete list of all User Manuals and Release Notes applicable to System 800xA is provided in System 800xA Released User Manuals and Release Notes (3BUA000263*).

System 800xA Released User Manuals and Release Notes (3BUA000263*) is updated each time a document is updated or a new document is released. It is in pdf format and is provided in the following ways:

- Included on the documentation media provided with the system and published to ABB SolutionsBank when released as part of a major or minor release, Service Pack, Feature Pack, or System Revision.
- Published to ABB SolutionsBank when a User Manual or Release Note is updated in between any of the release cycles listed in the first bullet.

A product bulletin is published each time System 800xA Released User Manuals and Release Notes (3BUA000263*) is updated and published to ABB SolutionsBank.

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
</table>
| MDD          | Message Data Definitions  
This is generated by the Aspect Wizard and contains the afw messages. |
| SDD          | Service Data Definition  
This is generated by the Aspect Wizard and contains the afw service specific information. |
Section 1 Introduction

The ABB System Extension Configuration and Packager tool is an automatic tool to create a System Extension Package for System 800xA.

The primary input for this tool are 800xA System specific files (.afw, .add, .mdd, .sdd, and so on) for the target extension.

You can add any other type of files and include it as part of extension targeted for 800xA. The output is a .msi file (Microsoft Installer) or a .exe file (Install Shield provided installation executable) containing library files as a part of the System Extension.

This tool is used to create a System Extension Package in the absence of Aspect Studio and Aspect Express.

Figure 1 shows the ABB System Extension Configuration and Packager Tool.
Section 1 Introduction

The following are the major areas included in the ABB System Extension Configuration and Packager Tool:

- **Files area** - Displays the selected files to which the package has to be created along with the target path.

---

**Figure 1. ABB System Extension Configuration and Packager Tool**

<table>
<thead>
<tr>
<th>Legend</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Notification area</td>
</tr>
<tr>
<td>2</td>
<td>System Extension area</td>
</tr>
<tr>
<td>3</td>
<td>Files area</td>
</tr>
<tr>
<td>4</td>
<td>Package area</td>
</tr>
</tbody>
</table>
Section 1 Introduction

- **System Extension area** - Allows the user to configure the System Extension details such as the System Extension Name, System Extension GUID, System Extension Version, System Extension Dependents, and System Extension Description, and generate a new System Extension dll.

  The user is allowed to browse for the System Extension dll, if available.

- **Package area** - Allows the user to generate the package for the configuration done in the Files area and the System Extension area.
Section 2  Working with the ABB System Extension Configuration and Packager Tool

This section describes the procedure to create a System Extension Package using the ABB System Extension Configuration and Packager Tool. The following is the procedure to create the package:

1. **Creating a project** - Requires manual operation to create a new project.
2. **Adding files to be packaged** - Requires manual operation.
3. **Providing System Extension Information** - Auto fill by the tool as per the project information provided. This is editable by user.
4. **Building a Package** - Initial data is Auto fill as per project description, and is editable by the user. Output is a .msi or .exe package containing the System extension and files configured in Step 2 and Step 3.

For information on saving or opening a project, refer to **Saving and Opening a project** on page 26.

Creating a project

This section describes the procedure to create a new project. Execute the following steps.

1. Select **New Project** from **File** or right-click the tool and select **New Project** from the context menu. The **SetNewProduct** dialog appears.
Figure 2. Creating a project

2. In **Set Project Name**, enter a name for the project.
3. In **Set Project Path**, select a project path using the browse button.
4. Click **OK** to save the changes.

**Adding files to be packaged**

This section describes the procedure to add the 800xA System specific files. Execute the following steps:

1. Select **File > Add Files** or right-click the tool and select **Add Files** from the context menu. The **Add Files** dialog appears.
Section 2  Working with the ABB System Extension Configuration and Packager Tool

Adding files to

2. Browse for the required file to create the package and click **Open**. The selected files are loaded to the **Library Files** column with the target path set to respective file type (for `.afw` file it is Import, for `.dll` or `.exe` file it is bin) in the **Target Folder** column.

You can modify the Target folder to facilitate sub folders and sequential installation. For example, `.afw` files can be grouped as import\01, import\02 where files need to be installed first is selected to import\01 and second is selected to import\02 (see Figure 4).

*Figure 3. Adding Files*
The target path is set to the respective file types (see Table 1). You can change the target path if required.

Table 1. Target path for various file types

<table>
<thead>
<tr>
<th>File Type</th>
<th>Target Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>.add</td>
<td>add</td>
</tr>
<tr>
<td>.afw</td>
<td>Import</td>
</tr>
<tr>
<td>.sdd</td>
<td>sdd</td>
</tr>
<tr>
<td>.mdd</td>
<td>mdd</td>
</tr>
<tr>
<td>Any other file types</td>
<td>bin</td>
</tr>
</tbody>
</table>
Figure 5. Loaded AFW Files
You can also select a folder containing the required files to create the package, through **File > Add Folder**.

The **Browse For Folder** dialog appears, to select the required folder. A message that prompts for a confirmation, appears. Click **Yes** to confirm.

The files in the selected folder are loaded to the **Library Files** column with the respective target path in the **Target Folder** column.
It is possible to add and package `.ocx` file type.

Select **File > Self Register** or right-click the tool and select **Self Register** from the context menu. The following figure appears, which shows only the `.exe`, `.dll` and `.ocx` files are available for self register in the tool:

![Select Files to Register](image)

Select the files to be registered during product installation and click **Select**.

To delete the loaded files, right-click the file and select **Remove Files** from the context menu. The following dialog appears.

![Select Files to remove](image)

Select the files to be removed and click **Remove**.
The column headers in the selected files view can be moved.

![Figure 6. Moving Column Headers](image)

You can use “System Variables” as Target folder. The System Variables like [ProgramFilesFolder] can be set to send a file to a required location. Figure 6 is an example to show on how the document is sent to [ProgramFilesFolder] followed by the required location.

**Providing System Extension Information**

This section describes the procedure to fill data for the targeted system extension. After filling the required informations, the tool will generate a new System Extension dll and add it as internal to the project. You can use this extension or can replace it by the extension dll created by you.

To generate a new System Extension dll, execute the following steps in the **System Extension** area of the ABB System Extension Configuration and Packager tool:

1. In the **System Extension Name** and **System Extension Description**, enter a name and description for the System Extension.

2. In the **System Extension GUID**, enter the System Extension GUID or click **Create GUID** to create a new GUID for the System Extension.

3. In the **System Extension Version**, enter the minor version, major version, and the revision of the System Extension.

4. In the **Build Number**, enter the user defined build number for the System Extension to be loaded. The default build number from the tool will be used if the build number is left unchanged at “0”.
Figure 7. Adding a System Extension

5. Click NewSystemExtensionDLL or right-click the tool and select Generate System Extension from the context menu, to generate the System Extension dll.

The System Extension path is updated below the System Extension Description text box.

Adding System Extension Dependency. Execute the following steps to add System Extension dependents:

1. In System Extension Dependency, click Add Dependency. The Dependent System Extension dialog appears:
2. Enter the System Extension details and click **OK** to create the dependency. The details appear in the **System Extension Dependency** area in the ABB System Extension Configuration and Packager tool (see Figure 9).

![Figure 8. Adding a System Extension Dependency](image-url)
To remove a System Extension Dependency, select the system extension and click **Remove Dependency**.

If the user browses for an existing system extension dll that is not created using the ABB System Extension Configuration and Packager tool or is not present in the `configuration.xml` file, enter the GUID, major and minor version, and revision for the system extension dll. The tool will then create a new or updated version of the system extension and save the information into the `.xml` file.
Saving and Opening a project

This section describes the procedure to save or open a project in the ABB System Extension Configuration and Packager Tool.

**Saving a Project.** Execute the following steps to save a project:

1. Select **Save Project** from **File** or right-click the tool and select **Save Project** from the context menu.
2. The **Save XML File** dialog appears. Browse to the required location to save the file and click **Save** to save the configuration as a .xml file.

**Opening a Project.** Execute the following steps to open a project:

1. Select **Open Project** from **File** or right-click the tool and select **Open Project** from the context menu.
2. The **Browse for Product Config File** dialog appears. Browse for the required configuration file and click **Open** to open the file.

The library files and system extension details are loaded into the ABB System Extension Configuration and Packager Tool.

The ABB System Extension Configuration and Packager tool also executes in a system that does not contain the Install Shield application. This tool can be used to configure the AFW files, generate the System Extension dll and save the configuration.

The configuration can then be moved to a system containing the Install Shield application. The user can reuse the created project and Configuration.xml file.

Building a Package

This section describes the procedure to build a package. Execute the following steps:

1. Create a project. See Creating a project on page 15.
2. Load the AFW files. See Adding files to be packaged on page 16.
3. Provide the System Extension information and generate the System Extension dll. See Providing System Extension Information on page 22.

4. Save the configuration. See Saving a Project.

   If there is an existing product configuration file, browse to the location and open the configuration file. See Opening a Project.

5. Click **Build** in the **Generate Package** area or click the **Build** menu in the ABB System Extension Configuration and Packager tool.

---

*Figure 10. Generate Package area*

The **System Extension Packager** dialog appears (see Figure 11). For more information, refer to System Extension Packager on page 27.

**System Extension Packager**

The System Extension Packager creates the package for the configured library files.
Figure 11. System Extension Packager

<table>
<thead>
<tr>
<th><strong>Field Name</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
<td>This is the name obtained from the System Extension Name. This field cannot be edited.</td>
</tr>
</tbody>
</table>
| Product Name in Programs and Features | Enter a name for the product that needs to be shown in “Programs and Feature”. This name could be different than your current product name. Make sure that the files will be installed in the “Product Name” folder and not in “Product Name in Programs and Feature”.

For example, in Figure 11 Product Name is “ABB System Extension Test Library”, hence the product will install all files to this folder, where programs and features will show the name as “ABB System Extension Test Library TestBuild 12_07_2015”.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Version</td>
<td>The MSI version that is shown in “Programs and Features”. By default the version is kept same as the system extension version. You can change this version during build time but the changes will not be saved. When you open the next dialog it will have the version of the system extension.</td>
</tr>
<tr>
<td>Product Code</td>
<td>The Product Code is the unique GUID of identifying a product release. Different versions and languages of a product must have different Product Codes. Also, a Product Code can be used to search the feature and product status.</td>
</tr>
<tr>
<td>Upgrade Code</td>
<td>The upgrade code is the unique GUID to identify a product family. That is, the same products with different versions have been shipped for a few releases. These products have different Product Codes, but they are linked together by using SAME Upgrade Code. For example, a product called “Happy MSI” is developed and this product has only one MSI package for deployment on client system. The first release of this product is the MSI package with name “version_1.msi”, and the second release is “version_2.msi”. Then, these two MSI must have same Upgrade Code. When users run “version_2.msi”, the Windows Installer will use the Upgrade Code to decide if previous versions of this product is already present on the system.</td>
</tr>
<tr>
<td>Install Path</td>
<td>The path where the product will be installed. You can give any path including System Variables like [ProgramFilesFolder].</td>
</tr>
<tr>
<td>Publisher</td>
<td>Provide any publisher name.</td>
</tr>
<tr>
<td>Support Phone Number</td>
<td>Provide your support phone number.</td>
</tr>
<tr>
<td>Publisher URL</td>
<td>Provide your publisher URL.</td>
</tr>
<tr>
<td>License File</td>
<td>Provide an End User License Agreement (EULA) file for your package. A default EULA file has been selected by the packager.</td>
</tr>
<tr>
<td>Icon File</td>
<td>Provide an icon file for your package. A default icon file has been selected by the packager.</td>
</tr>
</tbody>
</table>
The System Extension Packager includes the following:

- **Product Properties** and **Product Dependency** displays the properties of the configured product and the product dependents. This includes properties such as Product Name, Product Version, Product Code, Upgrade Code, Install Path, and Publisher information. See Configuration in the System Extension Packager.

- **Create ISM** generates a .ism file with the product properties for the configured library files. See Creating an ISM.

- **Generate Distribution** generates a package file, that is, the .msi file for the generated ISM file. See Creating the Package (.msi or .exe file).

### Configuration in the System Extension Packager

In **Product Properties** tab, the respective information of the project appears if it exists.

In case of a new project, the default values appear.

- **Product Name** displays the System Extension name. The user can enter a product name.

- **In Product Version, Major** will be 1 and **Minor** will be 0. The user can enter the major and minor versions, and also set the product revision in **Revision**.

- Select the **Single Setup** check box to get the System Extension package as a single executable.

- **Product Code** and **Upgrade Code** display new GUIDs.

Click **Product Code** and **Upgrade Code** to create new GUIDs for the Product Code and Upgrade Code respectively.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Notification</td>
<td>This area will show the current build activity. On success it will show the path of the generated build.</td>
</tr>
<tr>
<td>Package Type</td>
<td>msi - select this option if you want the package as a .msi file. exe - select this option if you want the package as a .exe file.</td>
</tr>
</tbody>
</table>
Section 2  Working with the ABB System Extension Configuration and Packager Tool

- **Install Path** displays the default path. Click ...
  to browse to the required location.

  It is recommended to retain the default path displayed in **Install Path**.

- Enter the publisher information in **Publisher**, **Support Phone Number**, and **Publisher URL**.

  In **Product Dependency** tab, the user can add the product dependents for the existing project.

  To add a dependency, click **Add**. In the **Browse for MSI Files** dialog, select the required `.msi` file and click **Open**. The information of the selected file will be loaded into the **Product Dependency** tab.

  If any product dependency has been added, during installation of the product the Product Name, Product Code and Product Version will be validated against the set dependencies. In absence of matching Product Code or Product Version a message box appears (see **Figure 12**), once you press **OK** the installation will be stopped.

![Figure 12. Missing Dependency](image-url)
To remove a dependent product, select the files and click **Remove**.

**Saving the Configuration.** To save the configuration done in the System Extension Packager, select **Save ISM** from **File** or right-click the System Extension Packager and select **Save ISM** from the context menu.

The configuration will be saved in the *.xml* file in which the library file and system extension configuration is saved (see **Saving a Project**).

**Creating an ISM**

This functionality is for advanced users. Hence keep the default *.ism* file generated by the tool and let the packager use the default file. Any manual modification done to the new ISM file will be saved in it.

Execute the following steps to create an ISM.

1. Select **Create New ISM** from **File** or right-click the System Extension Packager and select **Create ISM** from the context menu. The **Save .ism file** dialog appears.

2. Browse to the location and click **Save** to create the ISM file. The file is created in a folder **Configuration** in the selected location.

To open an existing ISM file:

1. Select **Open ISM** from **File** or right-click the System Extension Packager and select **Open ISM** from the context menu.

2. The **Browse for .ism file** dialog appears. Browse to the required *.ism* file and click **Open**.

The file details are loaded in the **Product Properties** and **Product Dependency** tabs.

**Creating the Package (.msi or .exe file)**

This section describes the procedure to create a *.msi* or *.exe* file. By default the tool selects *.msi* file type.
Execute the following steps:

1. Select **Generate Distribution** from **Edit** or right-click the System Extension Packager and select **Generate Distribution** from the context menu.

2. The **Save .ism file** dialog appears if the ISM file is not created. When the build has been started the notification appears in the Build Notification dialog (see **Figure 13**).

![Build Notification](image)

**Figure 13. Build Notification**

The package is created in the selected location of the project in the folder **Builds**.

If the build is successful a message box appears to open the build path.

The builds will be generated in your Project Folder \BUILDS\Date\Time, hence all your previous created build has been stored with date and time folder.

There is an internal check for build path. If the tool has found that the build path and build name has exceeded the system defined MAX_DIR_LENGTH (247 characters), the build location will be changed to Windows Active Directory\SECP_BUILDS. For example, if Active Directory is C:\ the build location will be C:\SECP_BUILDS.

3. **Figure 14** appears if .msi file type is selected.

**Figure 15** appears if .exe file type is selected.

Click **Yes** to open the installation package.
Figure 14. MSI Creation

Figure 15. MSI Creation
Section 3  Notifications

Table 2 describes the system messages that are shown in the ABB System Extension Configuration and Packager Tool.

The notifications appear in a yellow pane in the Notification area of the tool (see Figure 1).

Table 2. Notifications

<table>
<thead>
<tr>
<th>System Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current User is not Administrator. Please Start the application as Administrator or contact your Administrator to generate the build</td>
<td>This message is displayed if the existing user is not an Administrator.</td>
</tr>
<tr>
<td>It is not possible to generate package as Install Shield is not installed. Please install Install Shield to fix problem</td>
<td>This message is displayed if the Install Shield is not installed.</td>
</tr>
<tr>
<td>System Extension DLL and afw configurations not Present, Please generate a System Extension dll or browse for already generated System Extension dll and browse for afw configurations</td>
<td>This message is displayed while creating a new project.</td>
</tr>
<tr>
<td>Afw Configuration files are missing. Please Add afw configuration files</td>
<td>This message is displayed if the library files are not added.</td>
</tr>
<tr>
<td>System Extension DLL Not Present, Please generate a System Extension dll or browse for already generated System Extension dll</td>
<td>This message is displayed if the System Extension dll is not generated.</td>
</tr>
<tr>
<td>Please save the configurations to proceed</td>
<td>This message is displayed if the configurations done, are not saved.</td>
</tr>
</tbody>
</table>
Section 4  Product Installation

This section describes the procedure to install or uninstall the generated package.

**Installation.** Execute the following steps to perform the installation:

1. Double-click the *Setup.exe* file. This opens the Installation wizard.
2. Perform the installation in the required location. By default, the product is installed in `C:\Program Files (x86)\ABB\Library Packager and Configuration`.
   
   The product shortcut is also created in the desktop and the Startup menu.
3. In the **Programs and Features** list in the **Control Panel**, verify if the ABB System Extension Configuration and Packager is available.
   
   In the installed location, the *bin* and *Libs* folder must be created that includes the *.exe* and *.dll* files.

**Uninstallation.** Execute the following steps to uninstall the product:

1. Double-click the *Setup.exe* file. This opens the Installation wizard.
2. Uninstall the product.
   
   The product shortcut must be removed from the desktop and Startup menu.
   
   The *.exe* and *.dll* files must be removed from the installed location.

   In the **Programs and Features** list in the **Control Panel**, verify that the ABB System Extension Configuration and Packager is removed.
Section 5  Tips and Requirements

Tips

This section lists a few tips to be followed.

- While installing the package generated through the ABB System Extension Configuration and Packager tool, ensure that Product Dependency (if any) provided to the package is installed before installing the package. Otherwise, the installation fails.

- On successful installation of the Package, verify the Programs and Features list to check the installation of the package.

- In the 800xA Configuration Wizard, verify if the package exists in the Load System Extension. If there is any System Extension Dependent to the product, ensure that the dependent System Extension is loaded.

- On successful installation of the package, folders are created in the location as selected in Install Path while generating the package.

- The System Extension dll is present in the bin folder and the Library files are present in the import folder of the installation location.

- Usage of build number “0” is not recommended for System Extensions, as each build is incremental in nature and should start with minimum number as “1”. If default build number “0” is used, it causes an upgrade error in next build of the product. Always the build number should be incremental to distinguish the difference in builds.

- SECP tool provides both the flavor of installation kit (MSI and Exe) as provided by Install Shield. The default option is .msi type in the tool. Package generated with MSI option provides the possibilities to remove or repair the previous installed product. The package generated with Exe option tries to upgrade it and may fail if some files are locked, and not possible to upgrade. It
is recommended that in case of product upgrade the previous version of the product must be removed first either through some intelligence or manually so the new version of the product is installed without any issues.

- Always ensure that the Product name and version should be unique and it should not be already used product names. If user do it so, a file not found exception would raise by the Windows Installer for MSI file. Hence, always ensure to use unique product name for the MSI file.

Requirements

It is recommended to:

- Ensure that .NET Framework 4.5 is installed.
- Always ensure that Install Shield is installed to create the package.


ABB System Extension Configuration and Packager tool Version 6.0.1 requires InstallShield 2015 (Premier, Professional, or Express), Version 22.

To check your install shield version open Install Shield Window > Help > About Install Shield.

- Always ensure that the ABB System Extension Configuration and Packager tool is executed with Administrator privilege to create the package. Otherwise, the tool does not allow the user to create the package.

- Install Shield is available in three different editions Premier, Professional, and Express. The minimum requirement for ABB System Extension Configuration and Packager tool Version 6.0.1 is InstallShield 2015 Express edition.
Index

A
ABB System Extension Configuration and Packager tool 11
Adding files 16
Adding Folder 20
Adding system extension dependents 23

B
Build menu 27
Building a package 26

C
Configuration in system extension packager 30
Creating an ISM 32
Creating new project 15
Creating the package 32

F
Files area 12

G
Generating a system extension 22

N
Notifications in Library Packager 35

O
Opening a project 26
Opening an ISM 32

P
Package area 13
Product dependency 31
Product installation 37

Product properties 30
Product uninstallation 37

R
Recommendation 40
Removing files 21
Removing system extension dependents 25

S
Saving a project 26
Saving the configuration 32
System Extension 13
System extension packager 27

T
Tips 39